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NetWare 6 Support Pack 1 Readme
This document describes new features and known issues for NetWare® 6 
Support Pack 1. It supplements the Readme provided with the initial release 
of NetWare 6 and the NetWare 6 documentation.

NOTE: For information about additional issues discovered after the Support Pack 
release, see the NetWare 6 Support Pack 1 Readme Addendum (http://
support.novell.com/cgi-bin/search/searchtid.cgi?/10067742.htm) on the Novell 
Support Knowledgebase Web site.

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions 
within a step and items in a cross-reference path.

Also, a trademark symbol (®, TM, etc.) denotes a Novell® trademark. An 
asterisk (*) denotes a third-party trademark.
NetWare 6 Support Pack 1 Readme 7
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1 Overview
Overview 9

Welcome to NetWare® 6 Support Pack 1. This Support Pack provides a 
number of enhancements and fixes to the initial release of NetWare 6.

The Support Pack software is available for download from the Novell Support 
Web site at the following links:

Operating System software (http://support.novell.com/cgi-bin/search/
searchtid.cgi?/10067742.htm).

Client software (http://download.novell.com/sdMain.jsp), including the 
latest Novell® ClientTM for Windows*, ConsoleOne® snap-ins, NMAS 
client, and NICI client. Scroll to the section titled NetWare 6 Support 
Pack Client Updates.

Instructions for installing the Support Pack are included with the download in 
the following files: 

NW6SP1.TXT: Main installation instructions

NWOVLY.TXT: Instructions for creating an overlay installation

ZFSSP.PDF: Instructions for using ZENworks® for Servers to distribute 
the Support Pack

A summary of enhancements for the various Support Pack components is 
available in Chapter 2, “Summary of Changes,” on page 11.

A description of known issues for various Support Pack 1 components is 
located in the individual component chapters of this book.

HINT: For information about additional issues discovered after the Support Pack 
release, see the NetWare 6 Support Pack 1 Readme Addendum (http://
support.novell.com/cgi-bin/search/searchtid.cgi?/10067742.htm) on the Novell 
Support Knowledgebase Web site.

A description of known issues for the initial release of NetWare 6 is located in 
the NetWare 6 Readme.
NetWare 6 Support Pack 1 Readme
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2 Summary of Changes
This chapter provides a description of new features or enhancements to 
components in NetWare® 6 Support Pack 1. 

DNS/DHCP

The Novell® iManager browser-based DNS/DHCP management utility 
includes the following new features: 

Search feature for resource records

Multiselect deletion of objects

Pooled (Included) MAC address support

Automatic deletion of an A-type resource record when the corresponding 
PTR-type resource record is deleted (and vice versa)

Automatic update of the DHCP Server reference while importing the 
DHCP configuration

Documentation

The online help has been updated in several modules to reflect software 
changes.

Several manuals in the online documentation set have been updated to 
reflect software changes.
NOTE: No changes have been made to the printed NetWare 6 Overview and 
Installation Guide or the NetWare 6 Documentation CD.
Summary of Changes 11
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International Support
This release includes improved support for extended single-byte and 
double-byte characters for filenames, folder names, and eDirectoryTM 
objects.

iPrint/NDPS

Novell iManager has links directly to Netware Remote Manager for 
printers and the print services manager.

You can now edit the gateway load strings from Novell iManager.

In Novell iManager, IPP is automatically enabled when you create a new 
printer.

In Novell iManager, a tab for Windows XP drivers has been added to the 
Client Support page.

You can now add print drivers for all platforms in Novell iManager.

NetWare Remote Manager can now create reports about your print 
system.

You can start and shut down printer agents from NetWare Remote 
Manager.

Novell iPrint Map Designer has been enhanced to include the use of user- 
defined icons, font changes, and listing printers by container.

The iPrint Client has been updated. Users are automatically prompted to 
install the new client.

TTS is automatically enabled on NSS volumes where the Print Services 
Manager is located.

The duplicate driver ID issue has been fixed.

NetWare FTP Server

You can now log in from the FTP Client by giving the Fully Distinguished 
Name in the formats .cn=username.ou=ou1... or .username.ou1....

The STRU R option has been implemented.

 IGNORE settings no longer conflict with home server settings.

When administrating FTP Server from Web Manager, you can view the 
log files in non-English languages.
12 NetWare 6 Support Pack 1 Readme
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Logging in from the FTP client by specifying the country and locality 
objects is now functional.
For example, cn= admin .o= novell .l= utah .c= usa

The ABOR command is now functional.

NetWare Remote Manager

Several features have been added to NetWare Remote Manager that 
increase the functionality of existing server diagnostics and management 
features. For more information, see "New Features in NetWare 6, Support 
Pack 1" in "Introducing NetWare Remote Manager" in the NetWare 
Remote Manager Administration Guide.

NetWare Server Communication

You can now use an NSSWITCH.CONF file to control how NetWare 
Loadable ModuleTM programs communicate with the network to resolve 
names. For more information, see "Managing Name Services Using 
NSSWITCH.CONF File" in the Managing chapter of the Server 
Communications Administration Guide.

When troubleshooting DNS problems, you can now use 
NSLOOKUP.NLM to diagnose DNS network configuration problems. 
For more information, see "NSLOOKUP" in Utilities Reference.

NetWare WebAccess

Handheld PDA support has been added.

NetWare Web Search

A search site is now referred to as a virtual search server. In previous 
versions of NetWare Web Search Server, the term search site was defined 
as a collection of one or more indexes and related configuration files. To 
avoid confusion with the term Web site, the term was changed wherever 
it appeared in the documentation and in the variables and parameters. 

New variables and parameters that parallel the term virtual search server 
have been added. 

Although the new variables and parameters function the same as those in 
previous releases and those variables and parameters can still be used, we 
recommend that you start using the newer variables and parameters in 
order to avoid confusion.

The term collection has been changed to index. 
Summary of Changes 13
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Web Search now returns information from <TITLE>, <AUTHOR>, and 
<DESCRIPTION> tags found within XML documents. 
Web Search now includes improved support for PDF version 1.4.

Novell Advanced Audit Service (NAAS)

Four new events have been added for eDirectory Auditing:

DSE CHANGE ACL is generated when an object’s Trustee information 
is changed

DSE ENABLE LOGIN is generated when a user account is enabled

DSE DISABLE LOGIN is generated when a user account is disabled

DSE DETECT INTRUDER is generated when a user account is disabled 
because of intruder detection

Novell Cluster Services 

Novell Cluster ServicesTM now has improved integration with the NSS 
administration tools. This enables you to more easily and efficiently 
manage your shared storage.

Cluster volumes and pools can now be automatically cluster enabled at 
the time they are created. This new feature can be implemented using 
additional functionality that is now in the NSS ConsoleOne® snap-in. The 
snap-in also provides support for automatically adding CIFS, AFP*, and 
NCPTM advertising commands to cluster volume resource scripts.

Cluster-enabled volume resource scripts now update automatically when 
renaming or deleting pools or volumes.

The ADMIN_SERVER volume directory object is no longer necessary to 
manage shared storage.

The Cluster Volume Broker now includes a refresh feature and the ability 
to manage cluster volumes by right-clicking virtual servers to get the NSS 
Media tab.

You can now create DFS junctions on cluster volumes. Also, better 
integration of clustering with DFS and CIFS is possible by including 
virtual server setup information in NDS®. 

The eight-partition-per-device limit has been removed for the device 
containing the SBD partition.

The Trustbar module can now back up trustees at the root of a volume.
14 NetWare 6 Support Pack 1 Readme
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Novell eDirectory 
Novell eDirectory is now version 8.6.2.

Novell iFolder

iFolderTM applet additions:

An Explorer-like double-pane view of files/folders on server

The ability to create a new user account

The ability to handle large directories

Improved proxy support in the iFolder client and applet.

Novell iManager 

Multiple select with mouse (Shift+click).

Redesigned role-based administration pages.

Novell JVM for NetWare 

Novell JVM for NetWare is now version 1.3.1.

You can now use the File Browser utility to set NetWare file attributes.

This release is upgraded to version 6 of the accelerated graphics drivers 
and supports newer video graphics adapters.

Novell Licensing Service

In Novell iManager you can now view license certificate and policy 
information.

The NetWare Usage information in NetWare Remote Manager has been 
updated with an Advanced option.

Basic licensing information is now provided through the VERSION 
command at the server console.

Novell Modular Authentication Service (NMAS) 

NMAS is now version 2.02.

Novell Native File Access for Macintosh (AFP) 

Improved performance.
Summary of Changes 15
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Novell Native File Access for UNIX
Performing a large file copy on a traditional volume no longer aborts 
when the Cache_Aging_Interval is set to 0.

The Root access parameter in export options is now functional.

In order to give Modify and Root access to all clients, you need to 
explicitly add a trustee, enter an asterisk (*) in the Name field, and allow 
R/W or Root access using ConsoleOne.

The objects domain_U and domain_G are now created only if the passwd 
and group map are selected during migration.

NIS modules now refer to the Members attribute of the group. Using the 
SCHINST utility with the -n option moves the group's Group 
Membership list to the Members attribute. Also, for every user moved, it 
updates the user's Group Membership attribute and gives rights 
equivalent to that of the group.

Makenis now adds users to the Members attribute, gives users the rights 
equivalent to that of the group, and updates its Group Membership 
attribute.

The command line option -i has been added to the NISINST utility to 
specify the IP address to be attached to the NISServ object. This option is 
useful in a cluster environment and for servers with multiple NIC cards.

Novell Native File Access for Windows (CIFS) 

CIFS now supports Master Browser.

You can now access your DFS volumes through CIFS.

Novell NetStorage 

The Novell iFolder passphrase creation window is improved.

Support is now available for handheld devices running Windows CE.

The HTML interface supports right-clicking file and directory names.

Menu items which are not applicable in the current reference are grayed-
out/disabled.

If a user tries to copy over an existing file or directory, a prompt for 
permission to do the overwrite now appears.
16 NetWare 6 Support Pack 1 Readme

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

Novell Storage Services (NSS)
Background checker: The backgound checker periodically scans the file 
system and checks the IDs (including trustees) in the file system to make 
sure they are consistent with the entries in eDirectory. It deletes any old 
IDs that it finds and also fixes any NDS naming problems.

CIFS support for DFS: You can now access your DFS volumes through 
the CIFS protocol.

Clustering NSS volumes and pools in NSS: In ConsoleOne, you can now 
cluster enable a volume or pool when you create it.

DVD Support: You can now mount DVDs as NSS logical volumes.

Junctions: Junctions are virtual directories or folders that point to the root 
of a volume, which can be located in a different place on the same server 
or on a different server. This makes the volume location transparent to the 
user. At this time, this functionality can be accessed only through the 
WebDAV or CIFS protocol.

Multipath support: Multipath support is used to offline and reroute data 
paths in the event of a bad path or if maintenance is needed; this support 
is for multiple adapters on the same device. You manage this feature 
through NetWare Remote Manager.

Scripting

Perl5.003 for NetWare has been upgraded to Perl5.6 for NetWare. Perl5.6 
for NetWare is based on CPAN version Perl 5.6.1 and contains all the 
standard Perl extensions (Fcntl, IO, SDBM_File etc.). This also contains 
the Perl2UCS (formerly UCSExt) extension to access UCS components 
and CGI2perl for Web programming.

The NSN console command parser is improved.

Storage Management Services (Backup and Restore) 

SMSTM now supports backup of open files on NSS volumes.

TCP/IP 

This release includes configuration support in INETCFG for third-party 
vendor solutions for load balancing and fault tolerance at the NIC level.

TCP/IP information that was previously available only through the 
TCPCON utility can now also be viewed through the Protocol 
Information and subsequent links in NetWare Remote Manager.
Summary of Changes 17
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3 Support Pack Installation
Overwriting Files

During the Support Pack installation, newer files on the server are not 
overwritten. The installation program checks the version. If two files have the 
same version, the installation program then checks the date of each file. If the 
version and date are identical, the file is not overwritten. 

Files contained in .ZIP files are copied to the server and not compared to 
existing files. Files that are in use by a client are not overwritten.

Overwriting Files with an Overlay Upgrade

When you are using the overlay installation to upgrade a server to NetWare® 6 
and Support Pack 1 simultaneously, you should always overwrite newer files.

New Server Installation to an Existing NetWare 6 Tree Fails during 
Authentication

If the NCPTM Packet Signature option is set to 3 on a NetWare 6 Support 
Pack 1 server and that server holds the Master Root Replica, subsequent 
server installations into that tree might fail during authentication.

To resolve this, do the following:

1 On the server that holds the Master Root Replica, change the NCP Packet 
Signature option on the master server to 0 (zero), and then restart the 
master server for the change to take effect.

2 On the new server being installed, use the Back button in the installation 
program to return to the beginning and go through the installation screens 
again. 
Support Pack Installation 19
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This should allow the installation to authenticate and complete successfully. 
After installation, you can reset the NCP Packet Signature option back to its 
20 NetWare 6 Support Pack 1 Readme

original setting.

Adding a NetWare 6 Server to a Network Running NetWare 5.1 
Support Pack 4 with eDirectory 8

To add a NetWare 6 server to a system running NetWare 5.1 Support Pack 4 
with eDirectoryTM 8, do the following:

1 Download NetWare 6 Support Pack 1. 

2 Create an overlay CD following the instructions in 
\TOOLS\NWOVL\NWOVL.TXT of the NetWare 6 Support Pack 1.

3 Use NWDeploy on the overlay CD to prepare your tree for the NetWare 6 
server.

To Ensure Native File Access for UNIX Functionality, Upgrade 
Servers to the Latest Support Pack

In order for Native File Access for UNIX* to function correctly, you must 
upgrade all servers in the tree to the latest Support Pack. All NetWare 5.1 
servers must be upgraded to Support Pack 4 and all NetWare 6 servers must 
be upgraded to Support Pack 1. Native File Access for UNIX services will be 
functional only after they are upgraded.

Prerequisite for Updating the NMAS Login Method

NetWare 6 Support Pack 1 includes a fix for the change password function in 
the NMAS login method for AFP (LSMAFP.NLM.LMO). In order to use this 
updated login method, you must remove the current login method and 
sequence before installing NetWare 6 Support Pack 1 software. For specific 
instructions, see Updating the NMAS Login Method in Chapter 20, “Novell 
Native File Access for Macintosh (AFP),” on page 57.
NetWare 6 Support Pack 1 Readme
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4 ConsoleOne 1.3
ConsoleOne Will Not Load on NetWare Server after Installing 
GroupWise 6 Support Pack 1

You might receive the following error when you start ConsoleOne® on a 
NetWare® server after installing GroupWise® 6 Support Pack 1 and the 
GroupWise snap-ins on the server:

ERROR: java.lang.NoClassDefFoundError: com/novell/gw/util/
Resource

To resolve this error, remove the following GroupWise snap-ins directory 
from the server:

SYS:PUBLIC\MGMT\CONSOLEONE\1.2\SNAPINS\GROUPWISE

After you remove this directory, you will no longer be able to map a drive to 
the server and run ConsoleOne with the GroupWise snap-in. You will have to 
install ConsoleOne and the GroupWise snap-ins on a workstation in order to 
administer GroupWise. You will, however, be able to run ConsoleOne from 
the server without the GroupWise snap-in.
ConsoleOne 1.3 21

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001
22 NetWare 6 Support Pack 1 Readme
NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

5 DNS/DHCP
DNS/DHCP 23

Known Issues

When you create resource records, do not use wildcard characters to 
specify the owner’s name.

The Novell® iManager browser-based DNS/DHCP management utility 
does not support Netscape*.

Special Instructions

When you use the Object Selector to search for objects, ensure that the 
eDirectoryTM search context is correct by checking and, if necessary, 
changing the value in the Look In: field to reflect the correct context.

While deleting RRSet and IP Address objects using the multiselect delete 
feature, limit the number of objects to not more than 5000. Deleting a 
large number of objects at one time might take a long time to complete.

While creating a subnet, if you are selecting a default DHCP server, 
specify the eDirectory context of the subnet either using the Object 
Selector or by entering its Fully Distinguished Name. Do not use the type-
name format (for example, o=dnsdhcp.novell).
NetWare 6 Support Pack 1 Readme
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6 iPrint/NDPS
iPrint Client Error When Installing a Printer

After installing the Support Pack, users might receive the following error 
when they attempt to install a new iPrint printer.

Error message: iPrint Client - The print support 
file/driver was not found.
Error group: iPrint Client
Error code:  1047

The error is caused by a change in the NDPS® Broker’s Resource Manager. 
When the broker is loaded after the Support Pack installation, the Resource 
Manager checks the driver database for duplicate instances of identical drivers 
in NDPS\RESDIR and removes the duplicate drivers. If the printer agent 
references a driver that was deleted, the printer cannot be installed until a new 
driver is assigned to the printer agent

To resolve this issue, use Novell® iManager to assign a printer driver to the 
printer in question. 

1 In Novell iManager, click iPrint Management > Manage Printer.

2 Select the printer you want to change the driver assignment for.

3 Click the Drivers tab and then the platform for the driver you need to 
install. 

A driver will appear to be assigned to the printer, but the driver no longer 
exists in the database. You must reassign a driver anyway. 

4 Select a driver other than the one you need from the list, click Apply, 
select the correct driver for the printer and click Apply or OK.

This will ensure that the correct driver is selected.
iPrint/NDPS 25
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iPrint Port Conflicts with Web Servers
26 NetWare 6 Support Pack 1 Readme

If you upgrade from NetWare® 5 to NetWare 6 using the overlay method, or 
if you installed NetWare 6 using the Express Install option and then added the 
iPrint product, iPrint might not be configured correctly with the Web server on 
the NetWare 6 server.

In NetWare 5.1, the Novell® Enterprise Web Server was installed by default 
and captures port 443. After upgrading to NetWare 6, port 443 is still assigned 
to Enterprise Web Server. When iPrint tries to use port 443 for secure printing, 
the HTTPSTK reports an error on the logger screen.

In NetWare 6, the Express Install option installs the Apache Web server, which 
captures port 443. When iPrint tries to use port 443 for secure printing, the 
HTTPSTK reports an error on the logger screen.

Users might see the following error message when they attempt to use a secure 
iPrint printer:

Error message: HTTP 500 - Internal server error.
Error group: HTTP 
Error code: 500

To resolve this, reconfigure the ports for your Web server so that iPrint is 
assigned port 443. For more information on reassigning ports, see your Web 
server documentation or "How to Install and Configure NetWare Enterprise 
Web Server or Apache Web Server with Tomcat (http://developer.novell.com/
research/appnotes/2001/November/05/a011105.htm)" in Novell AppNotes® 
(November 2001).

Another option is to install iPrint on a NetWare 6 server that does not require 
a Web server.

Driver Installation Issues

If you are experiencing problems installing printers, ensure that the latest 
Service Pack for the workstation operating system is installed. Some driver 
installation problems have been resolved by Microsoft* Service Packs.

Lost Trustee Assignment When Using Migration Wizard

When migrating to NetWare 6 from an earlier version of NetWare using the 
Migration Wizard, the trustee assignment to SYS:\LOGIN is lost for the 
Public object. Therefore, NetWare 6 users will not have access to the directory. 
However, iPrint requires users to have access to this directory.

To resolve this, assign Read and File Scan rights to SYS:\LOGIN for the 
Public object.
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7 NetWare Enterprise Web Server
Setting Up Additional Document Directories on Remote Volumes

The Help topic for the Additional Document Directories screen shows the 
incorrect syntax for specifying a path to a remote volume. 

You must use the following syntax in the Map to Directory field when setting 
up an additional document directory that is located on a remote volume in your 
network:

servername/SYS:SYSTEM

You can also use the following syntax:

servername/SYS:
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8 NetWare FTP Server
NetWare FTP Server 29

Creating a File or Directory in a DOS Namespace on a Server with 
Double-Byte Characters

If you create a file or directory in a DOS namespace on a server with double-
byte characters, the file or directory is created on that server with the name 
specified. However, the message to the FTP client might contain a different 
file or directory name. This happens in particular with the 0x8374 character in 
Shift_JIS, 30D5 in Unicode that gets converted to 0x8354 in Shift_JIS, 30B5 
in Unicode.
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9 NetWare Migration Wizard 6
The latest version of NetWare® Migration Wizard is not included with 
NetWare 6 Support Pack 1 but is available from the Novell® Download Site 
(http://download.novell.com).
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10 NetWare Remote Manager
Disk Space Usage Limitation

With NetWare® 6 Support Pack 1, NetWare Remote Manager includes a new 
feature that lets you view a summary of disk space usage for an entire volume. 
You access this feature via the Disk Space Usage button on the Volume 
Information page.

This feature currently has a known limitation. That is, if the volume being 
scanned contains directories more than 17 levels deep from the root, the scan 
operation fails and a buffer overrun occurs. When NetWare recovers from this 
abend by suspending the thread (httpexpThreadx, owned by 
HTTPSTK.NLM), the Server Health light turns yellow. (Abend Thread count 
moves from 0 to 1.)

To clear the suspended thread, restart the server.

This limitation will be addressed in the next NetWare 6 Support Pack. In the 
meantime, an interim fix will be made available.
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11 Novell Advanced Audit Service
Novell Advanced Audit Service 35

Prerequisite for NAAS Utility

In order for the NAAS utility to function properly, you must download Java* 
Secure Socket Extension (JSSE) 1.0.2 from the JSSE Software Web site (http:/
/java.sun.com/products/jsse/index-102.html) and copy the files Jnet.JAR and 
JSSE.JAR to your ConsoleOneHome\ConsoleOneExt directory.

Excessive Memory Consumption

Using NAAS on a NetWare® 6 Support Pack 1 sever running on a Pervasive* 
database might cause the NetWare server that hosts the NAAS database to 
abend when there is excessive memory consumption. 

To avoid this, do one of the following:

Move the Pervasive database to a machine with 512 MB or more RAM.

When the memory buildup occurs, restart the Pervasive database on the 
server.

View the Loaded Module screen in the Monitor screen of the NetWare 
server and verify whether there is a steady and excessively high increase 
in the memory consumption of NWSQLMGR.NLM and 
NWODBCEI.NLM. 

If the memory is increasing, stop and restart the Pervasive database by 
using MGRSTOP and then MGRSTART at the server console. This 
refreshes the memory occupied by the Pervasive NLMTM programs; it 
does not disrupt auditing. The frequency of this start/stop can be 
determined by viewing the memory consumption behavior of the NLMs 
and NAAS configuration.

Install Pervasive SQL 2000i SP4, the latest version of the Pervasive 
database. For more details, see the Pervasive Web site (http://
www.pervasive.com).
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NAAS also works with the Oracle* database. As an alternate to the 
Pervasive database, Oracle 8i can be installed and configured on NetWare 

5.1 to be used as a NAAS database.

NAAS Components Fail to Come Up on a Nonreplica eDirectory 
Server

To resolve this, do one of the following: 

Load the NAAS Agent on the nonreplica server:

adagtset -nr username password

where the username is the dot-delimited Fully Distinguished Name for a 
user with the Supervisor right on the partition with the server.

Load the NAAS server on the nonreplica server by entering the following 
at the server console:

adsrvset -nr username password

where username is the dot-delimited Fully Distinguished Name for a user 
with the Supervisor right on the partition with the server.

The NAAS components can then be loaded following the normal procedure.

Deploying NAAS in a Mixed Environment with NetWare 6 and 
NetWare 6 Support Pack 1 Servers

NOTE: If you are configuring and using NAAS for the first time after installing 
NetWare 6 with Support Pack 1 and do not have NAAS on any other NetWare 6 
server, this issue isn’t applicable to your setup.

Auditing eDirectoryTM on NetWare 6 servers with Support Pack 1 installed 
uses a new eDirectory event template with Service Version 2.0, Service 
Identifier NDS®, and a new eDirectory event policy. The new eDirectory 
event template and eDirectory event policy are created as part of the default 
configuration of NAAS on NetWare 6 Support Pack 1.

Auditing eDirectory on NetWare 6 servers without Support Pack 1 continues 
to use the eDirectory template with Service Version 1.0, Service Identifier 
NDS, and the eDirectory event policy derived from it.

In order for eDirectory auditing to function on NetWare 6 Support Pack 1 
servers, you must reconfigure the existing NAAS framework using the NAAS 
snap-ins that ship with Support Pack 1.
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IMPORTANT: Only the administrator can reconfigure the existing NAAS 
configurations, using the NAAS default configuration utility.
To successfully audit eDirectory after installing NetWare 6 Support Pack 1, 
complete one of the following procedures.

If the Auditor has not manually created an eDirectory event policy template 
and an eDirectory event policy in the eDirectory partition (NAAS uses the DS 
Event policy template and DS Event Policy created by the NAAS default 
configuration utility on NetWare 6), complete the following steps:

1 Manually replicate the contents of the old eDirectory policy contents to 
the newly created eDirectory event policy.

2 Restart NetWare servers with Support Pack 1 after reconfiguring the 
NAAS framework.

3 To refresh templates and policies, restart ConsoleOne® after 
reconfiguring NAAS.

If the Auditor has manually created new eDirectory event policy template or 
eDirectory event policy in the eDirectory partition (by creating new ones in 
addition to the DS event policy template and DS event policy created by the 
default configuration utility on NetWare 6), complete the following steps:

1 For every eDirectory event template and eDirectory event policy in the 
partition (other than DSEventPolicyV2 and DSEventPolicyTemplateV2 
which are created by default), manually create a new eDirectory event 
template using the EVENTS.TXT file located in the 
SYS:\AUDIT\naasEvents folder on all NetWare 6 Support Pack1 servers 
and a new eDirectory event policy.

2 Manually replicate the contents of the old eDirectory policy contents to 
the newly created directory event policy.

3 Replicate associations to new event policies.

For example, associate the new eDirectory event policies to wherever the 
old ones were associated.

4 After reconfiguring the NAAS framework, restart your NetWare 6 
Support Pack 1 servers.

5 To refresh templates and policies, restart ConsoleOne after reconfiguring 
NAAS.
Novell Advanced Audit Service 37

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001
38 NetWare 6 Support Pack 1 Readme

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

12 Novell Client for Windows
See the Novell® ClientTM Readme (http://www.novell.com/documentation/lg/
noclienu/index.html) for issues related to the latest release of the Novell Client 
for Windows 95/98 and Novell Client for Windows NT*/2000/XP.
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13 Novell Cluster Services
Installation and Upgrade Issues

If you had a NetWare® 5.1 cluster installed and you performed an in-place 
upgrade on the servers in that cluster to NetWare 6, you must ensure the 
product entry for Novell Cluster ServicesTM is the proper version before 
installing NetWare 6 Support Pack 1.

To check the Novell Cluster Services product entry version number, do the 
following:

1 At the server console, load NWCONFIG.NLM.

2 Select Product Options and then View/Configure/Remove Installed 
Products.

3 Find the NWCS product entry and ensure the version number is 1.6.0 or 
later.

4 Repeat the above steps at every server in the cluster.

If the product entry version is earlier than 1.6.0, you must apply a patch to 
update the Novell Cluster Services product entry. Cluster servers that do not 
have the proper product entry version will abend when you install NetWare 6 
Support Pack 1.

To apply the patch, do the following:

1 Go to the Novell Support site  (http://support.novell.com/search/
kb_index.jsp) and search for TID number 2960777.

2 Click the filename to download the patch and follow the instructions 
included in the TID to update the Novell Cluster Services product entry.

3 Apply the patch to each cluster server that requires an updated Novell 
Cluster Services product entry.
Novell Cluster Services 41

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

In all cases except the one described above, we recommend you create a new 
CD image that combines Netware 6 and NetWare 6 Support Pack 1 in order to 
42 NetWare 6 Support Pack 1 Readme

install or upgrade Novell Cluster Services for NetWare 6 Support Pack 1.

Creating a New CD Image

Complete the following steps to create a new NetWare 6 and NetWare 6 
Support Pack 1 combined CD image:

1 On a local drive or a NetWare server volume, create an NW60CD 
directory at the root level.

2 Copy the entire NetWare 6 CD image to the NW60CD directory.

3 On a local drive or a NetWare server volume, create an NW60SP 
directory.

4 Copy the entire NetWare 6 Support Pack 1 image to the NW60SP 
directory.

If you downloaded the Support Pack from the Novell Download Web site, 
extract the Support Pack to the NW60SP directory.

If you have the Support Pack on CD, copy the entire NetWare 6 Support 
Pack 1 CD image to the NW60SP directory.

5 Select all files and directories in the NW60SP directory and copy them to 
the NW60CD directory.

6 Delete the \SPACK.IPS file and the \SP and \TOOLS directories from the 
NW60CD directory.

The NW60CD directory now contains a combined image of NetWare 6 
and NetWare 6 Support Pack 1.

Installing the NetWare 6/NetWare 6 Support Pack 1 Image

If you do not have NetWare 6 and Novell Cluster Services installed, use 
the image in the NW60CD directory and follow the instructions in the 
NetWare 6 documentation for upgrading or installing a new NetWare 6 
server and Novell Cluster Services.

If you already have NetWare 6 installed but have not yet installed or 
configured Novell Cluster Services, install NetWare 6 Support Pack 1 as 
you normally would and then install Novell Cluster Services by running 
NWDEPLOY from the NW60CD directory. 

During the Novell Cluster Services installation, uncheck the Skip File 
Copy check box to ensure the latest Novell Cluster Services files get 
copied to your servers.
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If you already have NetWare 6 and Novell Cluster Services installed, 
install NetWare 6 Support Pack 1 as you normally would. 
The NetWare 6/NetWare 6 Support Pack 1 image is required only if you 
want to add new nodes to an existing cluster. To add new nodes, run 
NWDEPLOY from the NW60CD directory instead of from the NetWare 
6 CD.

If you want to do a one-step upgrade from NetWare 5.1 to NetWare 6 
Support Pack 1 without having to go to NetWare 6 first, use the image in 
the NW60CD directory to perform the upgrade. Follow the instructions 
in the NetWare 6 documentation for upgrading a new NetWare 6 server 
and installing Novell Cluster Services.

NWDEPLOY Authentication Problems 

Before running NWDEPLOY, delete the PROGRAM 
FILES\COMMON\FILES\NOVELL\NI directory.

NWDEPLOY might be unable to authenticate to a new node when you 
attempt to add that node to an existing cluster. This problem occurs more 
frequently when either SLP or DNS isn’t configured properly on servers or 
clients.

This problem can be resolved by doing any of the following:

Before running NWDEPLOY, manually map a drive from your client to 
volume SYS: on the new node.

Add the server name and IP address of the new node to DNS.

Add the server name and IP address of the new node to the Windows 
Hosts file on the client machine where you will run NWDEPLOY.

Configure SLPDA to discover the server name of the new node.
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14 Novell eDirectory for NetWare
The Novell LDAP Server Does Not Support Downgrades from 
Support Packs

If you install a Support Pack and then later remove it, you might find that the 
LDAP server no longer responds to client requests. To resolve this, use 
ConsoleOne® to manually create new LDAP Server and Group objects, 
reassociate the LDAP Server object with the NCPTM Server object, and 
remove the obsolete Server and Group objects. 

1 Open a pre-Support Pack version of ConsoleOne that exactly matches the 
version of the LDAP server you want to run, and then log in with 
administrator privileges. 

2 At the same tree location where the upgraded LDAP objects exist, create 
a new LDAP Server object and a new LDAP Group object. 

These new objects contain the original defaults for the specific version of 
the LDAP server and group. Be aware that shared group objects are 
generally not compatible across multiple LDAP server versions. You 
need to restore any changes and associations that had been made to these 
objects prior to the installation of the Support Pack.

3 Review the properties of the NCP Server object associated with this 
Support Pack change.

3a Right-click the NCP Server object and then click Properties. 

3b On the Other tab, replace the LDAP server name listed in the 
Attributes list with the new LDAP Server object name.

4 Delete the obsolete LDAP Server object.

5 Delete the obsolete LDAP Group object after it is not being shared among 
other LDAP Server objects.
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Be sure to review the contexts of the LDAP Group and Server objects to 
ensure they refer to each other properly. Also make sure that security measures 

such as X.509 certificates are created and associated correctly and that SSL is 
configured accordingly.
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15 Novell GroupWise
ConsoleOne Will Not Load on NetWare Server after Installing 
GroupWise 6 Support Pack 1

You might receive the following error when you start ConsoleOne® on a 
NetWare® server after installing GroupWise® 6 Support Pack 1 and the 
GroupWise snap-ins on the server:

ERROR: java.lang.NoClassDefFoundError: com/novell/gw/util/
Resource

To resolve this error, remove the following GroupWise snap-ins directory 
from the server:

SYS:PUBLIC\MGMT\CONSOLEONE\1.2\SNAPINS\GROUPWISE

After you remove this directory, you can no longer map a drive to the server 
and run ConsoleOne with the GroupWise snap-in. You have to install 
ConsoleOne and the GroupWise snap-ins on a workstation in order to 
administer GroupWise. You can, however, run ConsoleOne from the server 
without the GroupWise snap-in.

Running the GroupWise 5.5 Enhancement Pack SP4 MTA and POA in 
Protected Memory Space

During a failover/migration of a cluster volume running the GroupWise 5.5 
Enhancement Pack SP4 MTA and POA in protected memory space, the 
Cluster Resource screen might prompt with the message Unload module 
anyway? Then the Cluster Resource Manager will report that the volume is 
in an Unloading state. It will remain in this state until you answer the 
prompt.

1 Answer N to place the migrating volume in a comatose state.
WARNING: If you Answer Y, the server will abend.
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2 Use Cluster Resource Manager in ConsoleOne to offline the volume.
3 Immediately online the volume to return it to a running state.

If you receive the Unload module anyway? message while unloading 
the protected address space but are not on a cluster, answer N to the prompt to 
unload the protected memory. Answering Y will abend the server.
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16 Novell iFolder
Novell iFolder 49

iFolder Is Not Automatically Restartable

The Novell® iFolderTM NLMTM runs in a protected address space on the server. 
This address space is not restartable via NetWare® Remote Manager or the 
protected address space server console commands. 

This means that if the iFolder protected address space faults, the server 
memory management system will not automatically close the address space 
and clean up the resources or restart the address space and reload the iFolder 
modules. This must be done manually.

Using the iFolder Client When Internet Explorer Has Bypassed Local 
Addresses and Proxy Exception Server Settings

Logging in to a proxy server via the iFolder client might fail if Internet 
Explorer has one or both of the following proxy settings:

Bypass Local Addresses for Proxy 

To view your proxy settings, go to Start > Settings > Control Panel > 
Internet Options > Connections > LAN Settings.

Proxy Exception (Advanced button on the LAN Settings tab) 

To correct this problem, upgrade the iFolder client to version 1.02.2 or later.
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17 Novell iManager 1.0 and iMonitor 1.5 

for Novell eDirectory 8.6

Novell iManager 1.0

Selecting User Objects. If you perform an operation that requires you to 
select a User object, and the list of User objects that match your search 
criteria contains more than 15 to 20 objects, you will be able to select 
objects only from the first objects in the list. If you click to see more User 
objects, you will no longer be able to select any objects. As a workaround, 
refine your search to find fewer User objects. This issue will be resolved 
in a future of release of Novell® iManager. 

Using the Keyboard to Expand Roles. If you use the Tab key to move 
to a role in Novell iManager and then press Enter to expand the role and 
view the tasks assigned to that role, your browser will GPF. To prevent 
this from happening, use the mouse to expand roles.

iMonitor 1.5

Restoring Custom Settings. Any custom settings you previously 
specified in the iMonitor configuration file are overwritten during the 
installation of NetWare® 6 Support Pack 1. To restore those settings, open 
NDSIMON.INI (located in the same directory as the iMonitor 
executable) and make the desired changes. To preserve your previous 
settings, you might want to manually copy them to another file before the 
installation.
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18 Novell Licensing
Demo Licensed Expired

The initial release of NetWare® 6 included a demo license. The demo license 
contained a 90-day expiration and an internal time limit of December 31, 
2001. This means that the license is already expired and is not usable.

In subsequent releases, like the international release of NetWare 6, the demo 
license was corrected to have a 90-day expiration and no internal time limit. 
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19 Novell Modular Authentication 

Service (NMAS)

When Upgrading to NMAS Enterprise Edition 2.0 Do Not Overwrite 
Newer NMAS Files

NetWare® 6 Support Pack 1 includes NMAS 2.03 Standard Edition and 
automatically installs it during the installation process. 

Once you have installed this version of NMAS Standard Edition, if you want 
to upgrade it to NMAS 2.0 Enterprise Edition, you need to answer No during 
the Enterprise Edition installation when asked if you want to replace the newer 
NMAS Standard Edition files on your system with the older ones included in 
NMAS 2.0 Enterprise Edition. By answering No and not overwriting the 
newer files, the previously installed NMAS Standard Edition will be upgraded 
to a full Enterprise Edition with full functionality and bug fixes.
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20 Novell Native File Access for 

Macintosh (AFP)

Mac OS X Issues

When you drag nested folders to the Trash from a workstation running 
Mac* OS X, an error message says that the folder is in use. You should 
drag files as a group to the Trash and then drag the folder to the Trash.

When you move or copy a file or folder to the same volume from a 
workstation running Mac OS X, the action is performed properly but you 
will see an error (-43 "File not found"). You can safely disregard this error 
message.

Copying Executable Files with Extended Characters to NSS Volumes

Copying an executable file that has an extended character (such as diacritical 
marks) in its name to an NSS volume will result in an error (-43 "File not 
found"). Rename the executable file without extended characters and then 
copy the file to the NSS volume.

Filename Character Limit

Version 2.2 of the Apple* Filing Protocol (AFP) limits filenames to a 
maximum of 31 characters while the Mac OS X implements AFP 3.0, which 
supports filenames longer than 31 characters. Because the AFPTCP NLMTM 
uses AFP 2.2, you should keep your filenames to no more than 31 characters 
to successfully copy and move files to an AFP volume.

Updating the NMAS Login Method

NetWare® 6 Support Pack 1 includes a fix for the change password function 
in the NMAS login method for AFP (LSMAFP.NLM.LMO). To implement 
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this change, you must first use ConsoleOne® from a Windows client and 
remove the current login method and sequence.
IMPORTANT: You should remove the current login method and sequence (as 
outlined below) before installing the NetWare 6 Support Pack 1 software. 
Otherwise, you will be required to add the new NMAS login method separately with 
ConsoleOne.

1 Ensure the NICI (Novell International Cryptographic Infrastructure) 
client software installed on the Windows workstation is at least the same 
as the NICI version on your NetWare 6 server (NICI 2.0.x).

You can verify the NICI version on the server with the NWCONFIG 
utility and then compare it with the NICI version on the Windows 
workstation by doing the following:

1a At the server console, load NWCONFIG.NLM.

1b Select Product Options > View/Configure/Remove Installed 
Products.

1c Locate the NICI entry and make sure the version number is 2.0.x.

1d Check the NICI client version on the Windows workstation by 
opening Add/Remove Programs in the Control Panel and viewing the 
list of currently installed programs.

If the NICI version on the Windows workstation is not the same as or 
later than the version on the server, you will need to install the 
appropriate NICI client upgrade. You can download the NICI client 
software from the Novell download site  (http://
download.novell.com/sdMain.jsp). Scroll to NICI Encryption 
Modules and download the appropriate module for your OS.

2 Start ConsoleOne on the Windows workstation.

3 Click File > Authenticate.

4 Log in as an administrator user to the server where you want to replace 
the AFP login method.

5 Delete the existing login sequence.

5a Expand the tree to locate the Security object, right-click the object, 
and then double-click Login Policy.

5b Select LSMAFP from the Defined Login Sequence list and then click 
Delete Sequence.

5c Click OK.
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6 Delete the existing login method.
6a Click Authorized Login Methods located under the Security object.

6b Right-click the LSMAFP item at the right and then click Delete NDS 
Object.

7 Restart the server.
Novell Native File Access for Macintosh (AFP) 59

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001
60 NetWare 6 Support Pack 1 Readme

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

21 Novell Native File Access for UNIX
Downgrade Not Supported

Downgrading Native File Access for UNIX to the previous release is not 
supported.

Error 9600

When NDSILIB is autoloaded during some operations, it might not load and 
will return Error 9600. To continue the operation, perform NFSSTOP and then 
execute the operation again.

If the Server IP Address Changes

If the server’s IP address changes, you must use ConsoleOne® to remove the 
old IP address and add the new IP address to the address restrictions list for 
the NFAUUser object.

Makenis Issues

Upon executing makenis in a server with no replica when the Master 
replica is down, instead of displaying a DS error, a series of messages 
similar to the following are displayed erroneously:

Nullpointer passed to routine Kmutex

Do not use makenis to delete users and groups. Use ConsoleOne instead.

Pkernel Messages

If the pkernel screen displays messages similar to the following after 
executing yppush, you can ignore them (they do not affect functionality in any 
way):

Out of memory, cannot create UDP Client handle.
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22 Novell Native File Access for Windows 

(CIFS) 

Certain Double-Byte Characters Not Supported in File and Directory 
Names

CIFS does not currently support certain double-byte characters used in file and 
directory names. Specifically, the double-byte backslash (\) and the double-
byte dash (-) characters do not work. (The Unicode value for the double-byte 
backslash is 0xFF3C; the Unicode value for the double-byte dash is 0x817C.) 
We recommend that you use the single-byte backslash and dash characters in 
file and directory names.

Double-Byte Characters in Usernames

You must use ConsoleOne® to manage CIFS passwords for users who have 
double-byte characters in their username.

Use ConsoleOne to Configure Your Windows/CIFS Network 
Environment

Once you have installed the NetWare® 6 Support Pack 1 software, you should 
configure your Windows/CIFS network environment with ConsoleOne. 
Previously, CIFS parameters were configured by manually editing the 
CIFS.CFG file. That file now contains a note telling you to use ConsoleOne 
for CIFS configuration.

If eDirectoryTM is reinstalled on a server running CIFS with NetWare 6 
Support Pack 1, ConsoleOne CIFS management does not automatically 
reimport the CIFS.CFG configuration into ConsoleOne. To reimport the 
configuration, remove the comment lines starting with ### from 
SYS:ETC\CIFS.CFG and then run CIFSSTOP and CIFSSTRT.
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Enable Unicode on a CIFS Server with DFS Junctions
Unicode must be enabled on a CIFS server in order for DFS junctions to work. 
You can enable Unicode in the following ways:

During the Installation: Make sure the Enable Unicode check box is 
checked on the first Server Properties screen.

After the Installation Using ConsoleOne: Right-click the Server object in 
ConsoleOne and then click Properties > CIFS > Config. Make sure the 
Unicode check box is checked and then restart CIFS by running 
CIFSSTOP and CIFSSTRT.

Domain Import Function

A new CIFS.NLM corrects a problem with the domain import function. For 
more information, see TID #2960727 on the Novell Support Knowledgebase 
(http://support.novell.com/search/kb_index.jsp).

CIFS Server Selected as a Master Browser in Domain Mode

In Domain mode, when the CIFS server is selected as a master browser, it 
maintains a list of servers in the domain only on the local subnet. 
Subsequently, servers in the domain that are located on other subnets will not 
appear in Network Neighborhood.
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23 Novell NetDevice NAS
Joining a NetDevice NAS Appliance into a NetWare 6 eDirectory Tree

NetWare® 6 Support Pack 1 includes fixes to eDirectoryTM for NetWare 6 that 
allow a Novell® NetDevice NAS appliance to join a NetWare 6 eDirectory 
tree. 

If you are planning to deploy a NetDevice NAS appliance into a NetWare 6 
eDirectory tree, you must make sure that the NetWare 6 server in the replica 
ring that holds the partition which the NetDevice NAS appliance is targeted to 
join is running NetWare 6 Support Pack 1 or later.
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24 Novell NetStorage
Setting the NetStorage/iFolder Passphrase

The NetStorage\iFolderTM passphrase is stored in the eDirectoryTM User 
object. A dialog to change the passphrase automatically appears when you 
select iFolder. The passphrase can also be set by editing the 
PASSPHRASE.HTM file that is included in the \iFolder directory.

Register All User Contexts for iFolder

All user contexts must be registered in the 
Xtier\Configuration\Xsrv\Authentication Domains registry area and must be 
set in the iFolder configuration. You can use the NSAdmin utility to change 
NetStorage-specific registry settings.

You can check the iFolder configuration at https://
hostname:iFolder_SecurePort/. iFolderServerMultiple trees are not currently 
supported. That is, users of multiple trees cannot access iFolder from 
NetStorage; each tree should have its own NetStorage server/admin. 

Ensure Admin Proxy User Is Logged In and Has Rights to All 
Contexts (iFolder)

Make sure the admin proxy user is always logged in and has rights to all 
contexts. You can check this by adding oneNet/SESSIONS to the end of the 
NetStorage URL. NetStorage uses the proxy user to set the encrypted 
passphrase in the User object. 

Using ConsoleOne®, click the Other tab on the User Properties page to see the 
xtier-ifolderpassphrase string (encrypted). The admin proxy user is configured 
during the NetStorage installation and can be changed after the installation by 
clicking the General link in the NSAdmin utility.
Novell NetStorage 67

NetWare 6 Support Pack 1 Readme
103-000171-001
March 5, 2002

Novell Confidential



Manual 99a38 July 17, 2001

Entering an Invalid Passphrase (iFolder)
If users enter an invalid passphrase that doesn't match the current iFolder 
passphrase, the PASSPHRASE.HTM file will continue to appear.

Ensure PASSPHRASE.HTM Is Posting the Correct URL (iFolder)

Make sure the PASSPHRASE.HTM form is posting to the correct URL. Open 
the PASSPHRASE.HTM form and then right-click and select View Source. 
Search for the word action and check the URL. The URL is in the form 
PROTOCOL://HOSTNAME:SECUREPORT/oneNet/iFolder/pph. Make sure 
the protocol is HTPS and the port is the correct secure port. Also make sure 
the hostname is correct. You can change the protocol, port, and hostname 
using the NSAdmin utility.

Changing eDirectory Password Invalidates iFolder Passphrase

If you change your eDirectory password, your iFolder passphrase becomes 
invalid. If this happens, reset your passphrase by re-entering the original 
passphrase that was created when your iFolder account was created. If you are 
using a browser to access NetStorage, you will automatically be prompted to 
reset your passphrase. If you are using Web Folders to access NetStorage, you 
must access the PASSPHRASE.HTM file in the iFolder directory to reset your 
passphrase.

Resetting the Passphrase

The user’s passphrase can also be reset at any time at the following URL 
where NetStorage is running: http://NetStorage_Server/oneNet/iFolder/pph.

HTTP Errors When Submitting Passphrase

Context configuration problems, port/protocol, and invalid DNS addresses 
usually cause HTTP errors when attempting to submit the passphrase form.

Port Conflicts or Invalid Port Settings

During the NetWare® 6 Support Pack 1 installation and configuration process, 
an administrator might inadvertently set the port number used by NetStorage 
to the same port number used by NetWare Enterprise Server. Manually 
changing the NetStorage port number after the installation also might cause a 
port conflict or an invalid port setting.

NetStorage requires the Apache Web Server and must use the same port 
number as the Apache Web Server. The default port number for NetWare 
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Enterprise Server is 80 for HTTP and 443 for HTTPS. If you have NetWare 
Enterprise Server installed, by default the Apache Web Server will get port 

51080 for HTTP and 51443 for HTTPS. If the NetWare Enterprise Server is 
not installed, the default port number for Apache (and NetStorage) is 80 for 
HTTP and 443 for HTTPS. Be sure that NetStorage in configured to the same 
port numbers as Apache.

NetStorage port conflicts and invalid port settings cause HTTP Forbidden 
errors when users attempt to create new folders in home directories and on 
mapped drives. These errors are characterized by Connection Refused IO 
errors and new folders not appearing after they are created.

Servers configured to use multiple IP addresses are less likely to have port 
conflict problems because each service can generally use its default port 
assignment.

To correct NetStorage port number conflicts or invalid port settings, edit the 
SETTINGS.PROPERTIES file in the 
SYS:\WEBAPPS\NETSTORAGE\WEB-INF\CLASSES directory. Change 
the port number to match the one that is listed in the 
SYS:\APACHE\CONF\ADMINSERV.CONF file. This port number can be 
found in the # Start Apache Services Port Configuration section of the file.

You can also edit the port number by clicking the WebDav Server link in the 
NSAdmin utility.

Downloading Folders Using a Browser Is Not Supported

The Novell NetStorage documentation indicates that you can download 
folders using a browser with NetStorage. This is incorrect. You can download 
individual files using a browser with NetStorage, but downloading folders is 
not currently supported.

You can create new folders or you can copy, delete, rename, or move existing 
files and folders by right-clicking the file or folder and then selecting the 
option you want.

Problems with Extended Characters in Text View

You might encounter problems viewing extended characters using the 
NetStorage Text View feature. Also, folders containing extended characters 
that are created using the Text View feature might not display correctly in 
either the Text View or the Folder View. This problem can be avoided by 
creating folders with extended characters or viewing extended characters 
using the NetStorage Folder View.
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LDAP Clear Text Passwords Are Required for Contextless Login
If you want to provide contextless login for users through NetStorage, you 
must enable LDAP Clear Text passwords. Contextless login lets users log in 
without specifying their entire User object context.

You can enable LDAP clear text passwords during the NetWare 6 installation 
or after the NetWare 6 installation using ConsoleOne.
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25 Novell Storage Services
Novell Storage Services 71

Failure to List Resources

NWBACK32 fails to list resources for backup on Windows 2000 and NT 
workstations with SLP as the discovery mechanism.

Logging In with a Windows Client

If you are trying to access a junction and you get an error that says Bad user 
name or password, this means that you used a different username and 
password to log in to your workstation and the network. 

DFS requires that you use the same common name and password for 
workstation and network login, otherwise login will fail.

Windows Client Limitation with DFS Junction Levels

Due to a limitation in Windows 95/98/ME/XP clients, if you create a junction 
that points to a volume that contains another junction, your second junction 
might fail because these clients don’t support multilevel junctioning (that is, 
having more than one junction in a path). Multilevel junctions are supported 
on Windows NT 4 and Windows 2000 clients.

DFS Requires Unicode Support

Unicode must be enabled on a CIFS server in order for DFS junctions to work. 
You can enable Unicode in the following ways:

During the Installation: Make sure the Enable Unicode check box is 
checked on the first Server Properties screen.

After the Installation Using ConsoleOne®: Right-click the Server object 
in ConsoleOne and then click Properties > CIFS > Config. Make sure the 
Unicode check box is checked and then restart CIFS by running 
CIFSSTOP and CIFSSTRT.
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Using MONITOR.NLM to Set NSS Startup Parameters
The file that you need to modify to set NSS startup parameters at the server 
console is documented incorrectly in MONITOR.NLM. Whenever you are 
instructed to modify the STARTUP.NCF file, modify the NSSSTART.CFG 
file instead.
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26 Novell TCP/IP
Configuration through INETCFG

If the NETINFO.CFG file is corrupted and upon loading INETCFG you 
get a message asking you to reconfigure, delete the TCPIP.CFG file. 
HINT: Once the network configuration of the server is complete, we recommend 
that you back up the NETINFO.CFG, NETINFO.CHK, and TCPIP.CFG files. Then, 
in case of corruption, you can restore from the backed-up configuration. 

In machines with multiple NICs, if already-in-use IP addresses are 
selected for binding, an ARP conflict error message is displayed (in the 
logger screen) for each binding. The system should automatically trigger 
unbinding of the IP addresses. If the binding persists, manually delete the 
bindings and reinitialize the system.

IP Trace

A blank space is not permitted between the command arguments and the 
equal sign (=) following them. 

Source option is not supported in this release.

In some destination addresses, the utility stops at the hop before the 
target. 

NIC Teaming

Currently, only one user-specified protocol is supported.
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27 Scripting Products
Perl Issues

Failure of UCX methods is indicated by an unknown error. The error 
description given by the UCX call is currently not available for the Perl 
script

If a script has just use Perl2UCS or require Perl2UCS and no 
object instantiation through Perl2UCS->new(...), the script will 
abend.

Complex scripts running from the console might give the message 
Process did not relinquish control frequently.

Scripts that contain an infinite loop can be terminated by Ctrl+Z, but not 
Ctrl+C. When Ctrl+Z is pressed, it breaks the loop and expects any key 
to be pressed (which will be indicated on the Perl output screen) before 
the Perl output screen can be exited.

Press Ctrl+Z after pressing Enter to execute the next command in the Perl 
debugger.

When multiple CGI scripts (more than about 40) each doing complex 
operations are run simultaneously, the Web server will hang or abend.

The following Perl functions are either not yet implemented in NetWare 
or are not applicable in the NetWare environment:

alarm chown chroot

endgrent endpwent fork

getgrent getgrgid getgrnam

getpgrp getppid getpriority
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getpwent getpwnam getpwuid
The truncate built-in procedure does not function reliably.

The readlink built-in procedure always returns an undefined value.   
According to Perl's definition of the function, this is the correct 
behavior on a system such as NetWare® that does not support 
symbolic links. 

The system built-in procedure is supported. However, the shell it 
invokes is the standard NetWare console. Note that the console does 
not support I/O redirection, pipes, variable expansion, or filename 
globbing. This is a port of Perl, not UNIX. 

link rewinddir setgrent

setpgrp setpriority setpwent

symlink syscall telldir

times
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28 Storage Management Services (SMS)
NWBACK32 fails to list the NetWare® servers in Windows 2000 and 
Windows NT workstations when SLP is used and the Novell® ClientTM is 
installed with only IP. To resolve this, enable the Active and Static 
discovery properties in the Novell Client.

Pressing F1 to access the context-sensitive help file for W32SMDR is 
currently not supported. Click the Help button in the GUI to view the 
help.
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29 Time Management
If your server is not in sync, it could be due to one of the following:

You do not have configured sources set to On even though the source is 
specified in the configured sources list.

Your source server is IP only and your configured source is the IPXTM 
server name. You need to specify the IP address or DNS long name in the 
configured source list.

You have multiple NICs in the server and you are specifying an IP or NTP 
source. (This is a timing issue and doesn’t occur in all multiple-NIC 
environments.) 

For environments with multiple NICs (such as NetWare® routers and 
multiple-NIC cluster environments) that experience problems, insert the 
following at the end of your AUTOEXEC.NCF file:

unload timesync

load timesync

This allows the TCP/IP stack to finish coming up, to bind and initialize to 
all the interfaces, and to then restart Timesync.

Directory Tree Mode (default configuration): In order for Timesync to 
function in Directory tree mode, it uses SLP. In some mixed SLP/tree 
configurations, the secondary server doesn’t find the Single/Reference 
server with the Timesync service via SLP. 

If you experience issues in your environment after having the Single/
Reference and Secondary servers all contact the Same Directory Agent, 
set your configured sources to On and contact your Single, Reference, 
Primary, or NTP source via the IP address or DNS long name.
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